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Overview
NoteBook for Windows 95/NT is a small utility that will allow you to quickly create and store short notes and lists.

Table of Contents 
The main window displays a Table of Contents built from the first line of each individual NoteBook page. Double-click on an entry
in this table to display and edit a specific note. You may cut, copy and paste entire notes from the Table of Contents view.

Drag & Drop
NoteBook for Windows 95/NT supports a Drag & Drop interface. Drop NoteBook document PADs on the Table of Contents view 
to quickly open a new document. Drop an ASCII text file on an individual NoteBook page to easily add text to existing NoteBook 
documents.

Priorities 
NoteBook pages can be marked as urgent and completed. Ctrl-Click an item to mark it as urgent, or Shift-Click to mark it as 
completed.

Sorting 
NoteBook pages can be quickly sorted by contents or priority.

Smart Table Editing
Pages can be inserted and removed from the Table of Contents view. Individual pages can also be easily moved up and down in
the list.

Time Stamps
Insert timestamps at any point in a note. Use F5 to insert the date and time at the cursor while editing. Select Options from the 
File menu to set the time stamp format.

Find & Replace
Search for words and phrases anywhere in a note pad, and optionally make replacements.

Built-in Help
The first note in any new pad contains a brief set of instructions. Erase these instructions and replace them with the first note to 
start your new pad..

Auto Saving



NoteBook can be set to automatically save changes as you work. Select Options from the File menu to configure this setting.

Uses
NoteBook's compact screen size makes it an ideal PostIts-style utility for Windows users. Its ability to quickly handle multiple 
pads lets you create different lists for all of your projects and computing activities.

Internet
Internet users will find it handy for storing URLs and email addresses. Highlight a web site URL, press the Visit button on the 
toolbar ribbon and your web browser will be launched and you will go directly to the web site you’ve selected. Load a different 
pad for use as a to-do list. Keep yet another pad for use as a project list. NoteBook can also be used as a small address book, 
or as a temporary storage site for all those other bits of information you'll file elsewhere.

Telephone Dialer
NoteBook can also be configured to use your computer system’s modem to dial telephone numbers stored on individual 
NoteBook pages. 

Programmers
Programmers can use it to store snippets of code and development notes. HTML authors can use it to save examples of Web 
page source. Writers and stenos can use it to store oft-repeated bits of text in an easy-to-access format without relying on 
complex or finicky clipboard managers.

Limitations
NoteBook pads can have up to 50 pages. Each page can contain approximately 800 words of text. 

NoteBook is not a database, nor is it a word processor.

NoteBook was designed as a means of keeping short notes and lists about software development projects. NoteBook was 
originally written for Macintosh and later converted to MS Windows.

Desktop Locations
NoteBook’s location on the desktop is saved when the program is exited. Whenever you start NoteBook it will reappear on the 
desktop where you last placed it. NoteBook property sheet locations are also stored and reused the next time they are opened.

Taskbar Tray
NoteBook for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. This 
option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing NoteBook
Installation
To install NoteBook for Windows 95/NT on your computer simply create a new, empty folder and place the files; 
NOTEBOOK.EXE, NOTEBOOK.HLP and NOTEBOOK.CNT there.

NOTEBOOK.EXE - The NoteBook Application
NOTEBOOK.HLP - The Windows 95/NT Help File
NOTEBOOK.CNT - The Help Contents File

To integrate NoteBook for Windows 95/NT with the MS Windows Explorer select the NoteBook Explorer Setup property sheet 
while NoteBook is running.

Note If you have an earlier version of NoteBook for Windows 95/NT installed on your computer, simply replace the 
NOTEBOOK.EXE, NOTEBOOK.HLP and NOTEBOOK.CNT files with the newer versions. NoteBook stores configuration 
information in the MS Windows 95/NT System Registry.

Note If you’ve used NoteBook for Windows 95/NT before you may find two (2) files named NOTEBOOK.GID and 
NOTEBOOK.FTS in the disk folder containing the NoteBook application. These files are created and maintained by the MS 
Windows Help program and should be retained. The GID and FTS files store the search word list you create as well as 
bookmarks, annotations and desktop locations, font selections and window sizes.

Note The NOTEBOOK.INI file is no longer used and can be deleted. The various application settings specified in the NoteBook 
Options property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT
System Registry.

Note Some earlier versions of NoteBook for Windows 95/NT included a NOTEBOOK.WRI documentation file. This file has been 
replaced by the NOTEBOOK.HLP and NOTEBOOK.CNT files and can now be deleted.

Warning If you rename the NOTEBOOK.EXE file you must also rename the HLP file using the same basename. For example if 
you change the NoteBook application file name to NewName.exe, rename the help file to NewName.hlp. Do not rename the 
NOTEBOOK.CNT file however. The HLP and CNT files must reside in the same folder as the NoteBook application file itself.



Configuring NoteBook
NoteBook Options
Select the File | Options menu item to display the NoteBook Options property sheet. This window will allow you to change the 
various NoteBook program settings listed below.

Confirm TOC Editing Changes
Check this item to display a dialog box confirming TOC editing deletions and changes. It is recommended that you keep this 
item checked.

Dark Window Backgrounds
Check this item to display the text in list windows with a dark background instead of the paper white background MS Windows
normally uses when displaying text.

Number Pages in the TOC View
Check this item to display individual NoteBook page numbers when viewing the TOC. If this item is not checked individual 
page titles in the TOC will be displayed with a leading ‘*’.

Show Tool Bar Tips
Check this item to display small popup tip windows when the mouse pointer is placed over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Launch Multiple Instances
Check this item to allow more than one instance of NoteBook to be run on the desktop.

Place Icon in the Taskbar Tray
Check this item to display a small NoteBook program icon in the Taskbar Icon Notification Tray. If this item is selected and the 
NoteBook window is minimized a button will not be added to the Taskbar, to restore the NoteBook window on the desktop 
press the small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running programs.

Note When this option is selected, clicking on the Close box in the upper-right hand corner of the window title bar will 
minimize NoteBook instead of closing the application. To quit NoteBook right-click with your mouse on the NoteBook icon in 
the Taskbar tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Minimize Program Icon at Startup
Check this item to start NoteBook for Windows 95/NT as a minimized icon on the Explorer Taskbar or Icon Notification tray. 
This option is useful if you’ve configured NoteBook to be started whenever MS Windows is booted.

Confirm Program Exit
Check this item to confirm quitting NoteBook for Windows 95/NT. When this option is selected you will be prompted to confirm
your intention to exit NoteBook and return to the MS Explorer desktop. This item is useful if you run NoteBook from the tray 
and wish to avoid accidental exits when you right-click on the NoteBook tray icon.

Open Locked Note Pads as Read Only
Check this box to open write protected files as read-only. If this item is not checked and a locked file is opened you will be 
prompted to load the file as read-only.

Automatically Save Editing Changes
Check this box to automatically save editing changes while you work with a document. If this box is not checked you will be 
prompted to save your changes before closing documents that have been edited.

Make Backup Copies
Check this box to automatically make a backup copy of documents that have been edited. Backup files will have the same file 
name with the prefix Backup of    added.

NotePad
Enter the file name of the NoteBook document to be loaded at startup. Press the browse button [...] to the right of this entry 
field to use the standard MS Explorer File Browser for automatic file selection.

Use this Note Pad at Startup
Check this box to load the NoteBook document specified above whenever NoteBook for Windows 95/NT is launched. If this 
item is checked the NoteBook document you specified above will always be opened and displayed automatically when 
NoteBook is started. If this item is not checked NoteBook will open the document that was in use when NoteBook was last 
run.

OK
Press this button when you have completed your selection of NoteBook program options. When you press this button the 
NoteBook Options property sheet will be closed and your settings will be saved.



Cancel
Press this button to close the NoteBook Options property sheet without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the NoteBook Help window and go directly to the Configuring NoteBook topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the NoteBook Options
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



NoteBook Time Stamp Settings
NoteBook Time Stamp Settings
Select the File | Options menu item to open the NoteBook Options property sheet and then click on the Time Stamp tab to 
display Time Stamp Settings. This window will allow you to specify the time stamp format used when inserting timestamps in 
NoteBook pages. A description of the various settings follows.

Regional
Press this button to open and view the MS Windows 95/NT Regional Settings Control Panel. These setting determine the 
Time and Date formats that MS Windows uses. It is from here that you can specify the time format for 12 or 24 hour time 
strings as well as the format for long and short date strings. The settings specified here will be used when NoteBook inserts a 
timestamp in a NoteBook page.

As you make changes to the Time Stamp settings the currently selected format will be displayed in the NoteBook Time Stamp 
Settings property sheet. The format displayed will be what is inserted when you add timestamps to NoteBook pages.

Use System Date
Check this box to include the current system date in timestamps inserted in NoteBook pages. If this box is checked the long 
and short date format radio buttons directly beneath this item will be active.

Long Dates
Check this radio button to display dates in a long format such as; Mon, Jan 1 1997 or Monday, January 1 1997.

Short Dates
Check this radio button to display dates in a long format such as 01/01/97.

Use System Time
Check this box to include the current system time in timestamps inserted in NoteBook pages. If this box is checked the time 
and date format radio buttons directly beneath this item will be active.

Date - Time
Check this radio button to display the current system date before the time.

Time - Date
Check this radio button to display the current system time before the date.

Warning Sounds with Dialog Boxes
Check this item to play a short warning beep whenever NoteBook displays a warning or error dialog box..

OK
Press this button when you have completed your selection of Time Stamp settings. When you press this button the NoteBook 
Time Stamp Settings property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the NoteBook Time Stamp Settings property sheet without making any changes. If you have made 
any changes to the settings, and then press this button your changes will not be used, and your previous settings will remain 
in use.

Help
Press this button to open the NoteBook Help window and go directly to the NoteBook Time Stamp Settings topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the NoteBook Time 
Stamp Settings window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



NoteBook Page Setup
NoteBook Page Setup
NoteBook can be configured to use custom headers and footers when printing NoteBook documents using the File | Page 
Setup menu item.

NoteBook File Information Macros
Displayed below is a list of NoteBook File Information Macros available for inclusion in custom headers and footers.

$F = File Name The current NoteBook document name with full drive and path will be inserted at the point where 
the $F macro appears.

$f = File Name The current NoteBook document name without a drive or path will be inserted at the point where 
the $f macro appears.

$P = Page Number The current page number will be inserted at the point where the $P macro appears.

$T = Current Time The current time will be inserted at the point the $T macro appears.

$D = Current Date The current date in long format will be inserted at the point the $D macro appears.

$d = Current Date The current date in short format will be inserted at the point the $d macro appears.

Any other text specified in a header or footer will be treated as literal and will appear just as defined. To include the actual ‘$’ 
character in a header or footer use ‘$$’.

Header
Define the header text you wish to have appear at the top of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a header.

Print Header
Check this item to enable the header defined above. If this item is not checked the header you defined above will not be 
printed. This item is included to facilitate turning header printing on and off with out deleting the header you have defined

Center Header
Check this item to center the header at the top of each printed page. If this item is not checked the header you have defined 
above will be printed starting at the left margin.

Footer
Define the footer text you wish to have appear at the bottom of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a footer.

Print Footer
Check this item to enable the footer defined above. If this item is not checked the footer you defined above will not be printed. 
This item is included to facilitate turning footer printing on and off with out deleting the footer you have defined

Center Footer
Check this item to center the footer at the bottom of each printed page. If this item is not checked the footer you have defined 
above will be printed starting at the left margin.

Printer Page Margins
Use the following four entry fields to specify the page margins to be used when printing documents. Margin widths are 
expressed in decimal inches, for example 1.25, 0.50, .25 or 1 are all valid margin widths.

Left
Enter the left margin width in this field. NoteBook document text will be printed starting from this position on the left side on 
the page.

Right
Enter the right margin width in this field. NoteBook document text will be printed across the page to this position.

Top
Enter the top margin width in this field. NoteBook document text will be printed starting from this position at the top of the 
page.

Bottom
Enter the bottom margin width in this field. NoteBook document text will be printed down to this position at the bottom of the 
page.



Note If you have defined a header or footer to be printed on each page make certain that you set the top and bottom margin 
widths to at least 0.10 inches or your document text will be printed directly on top of the headers and footers you defined.

OK
Press this button when you have completed your selection of Page Setup settings. When you press this button the Page 
Layout property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Page Setup property sheet without making any changes. If you have made any changes to the 
Page Layout settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the NoteBook Help window and go directly to the NoteBook Page Setup topic.

Note The Page Setup settings you have selected will be saved when you press the OK button. The desktop location of the Page
Setup window itself will also be stored. Your Page Setup settings will be saved in the MS Windows 95/NT System Registry.



NoteBook Serial Settings
NoteBook Serial Settings
Select the File | Options menu item to open the NoteBook Options Property Sheet. Select the Serial Tab to specify the serial 
port your modem is connected to. This window will allow you to change the various NoteBook program settings listed below.

Channel
Select the COM port your modem is connected to. Communication ports COM1 through COM4 are available for dialing.

Baud Rate
Select the baud rate your modem uses. Any Baud Rate from 110 bps up to the maximum speed of your modem can be 
specified here.

Word Size
Select the word size to be used for dialing your modem. The most common Word Size for this setting would be 8 bits.

Parity
Select the type of parity to be used for error checking. The most common Parity setting would be None.

Stop Bits
Select the number of stop bits to be used for framing. The most common Stop Bit setting would be 1.

Flow Control
Select the type of flow control to be used for handshaking. The most common Flow Control setting would be None.

Defaults
Press this button to use a generic serial port setting of “1200,8,N,1”. If you have trouble connecting to you modem using 
custom settings specified above try using the default settings instead. Modem speed is not important when dialing. The baud 
rate will only determine the speed at which individual digits are sent to your modem for dialing.

Note The settings you specify here will only be used by NoteBook for dialing via your modem. They will in no way change 
settings you normally use for other modem operations such as Internet Access or Dial Up Networking.

OK
Press this button when you have completed your selection of NoteBook program options. When you press this button the 
NoteBook Options Property Sheet will be closed and your settings will be saved.

Cancel
Press this button to close the NoteBook Options Property Sheet without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the NoteBook Help Window and go directly to the NoteBook Serial Settings topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the NoteBook Options
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



NoteBook Modem Settings
NoteBook Modem Settings
Select the File | Options menu item to open the NoteBook Options Property Sheet. Select the Modem Tab to specify modem 
settings used to dial your telephone. This window will allow you to change the various NoteBook program settings listed below.

Speaker Volume Setting
Use the three (3) radio buttons provided to specify the speaker volume to be used when dialing telephone numbers. You may 
specify a Low, Medium or High speaker volume for dialing operations 

Wait for Dial Tone
Specify the number of seconds to wait for a dial tone before dialing. You may use a number between 1 and 15 seconds for 
this setting.

Use Touch Tone Dialing
Check this item to use Touch Tone dialing. If this item is not checked dialing will be carried out using Pulse codes in place of 
DTMF signals.

Modem Initialization String
Specify the command string to be issued to your modem before attempting to dial. Check your modem documentation for 
command strings specific to your modem. A common setting for this command would be “AT S0=0 E0 V1 Q0 &C1 &D2 X4”.

Reset
Specify the command to be used to reset your modem. A common setting for this command would be “&F”.

Tone
Specify the command to be used to select tone dialing. A common setting for this command would be “DT”.

Off Hook
Specify the command to be used to go “off hook”. A common setting for this command would be “H1”.

Command
Specify the command prefix your modem uses. A common setting for this command would be “AT”.

Pulse
Specify the command to be used to select pulse dialing. A common setting for this command would be “DP”.

Hangup
Specify the command to be used to hang up. A common setting for this command would be “H0”

Defaults
Press this button to assign default command strings for the various modem settings. The default modem settings that are 
assigned will work with most modern modems.

OK
Press this button when you have completed your selection of NoteBook program options. When you press this button the 
NoteBook Options Property Sheet will be closed and your settings will be saved.

Cancel
Press this button to close the NoteBook Options Property Sheet without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the NoteBook Help Window and go directly to the NoteBook Modem Settings topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the NoteBook Options
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



Printing NoteBook Pages
Printing NoteBook Documents and Pages
To print NoteBook documents select the File | Print menu item. Entire NoteBook documents can be printed, or a range of pages
can be printed selectively. NoteBook will automatically skip blank pages when printing.

When the NoteBook Print command is selected the standard MS Windows 95/NT Print dialog box will be displayed. Use this 
window to specify how you would like to print a NoteBook document. The following selections are available:

All 50 Pages
Check this button to print the entire NoteBook document. All currently active pages will be printed, one NoteBook page per 
sheet of paper. Blank pages will be skipped if they do not contain any text.

Pages
Check this button to print a range of pages in the current NoteBook document. Only currently active pages in the range you
specify will be printed, one NoteBook page per sheet of paper. Blank pages will be skipped if they do not contain any text. 
To print a single NoteBook page use that page’s number for both the From and To entries. For example to print page 
number 9 enter a 9 in both the From and To entry fields.

Tip The page number of each individual NoteBook page is displayed in the lower right hand corner of the status region.



NoteBook Explorer Setup
NoteBook Explorer Setup
Select the Help | Setup menu item to display the NoteBook Setup property sheet. This window will allow you to integrate 
NoteBook for Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS Explorer
shortcuts.

Create a Start Menu Item
Check this item to create a NoteBook Start Menu entry. The NoteBook for Windows 95/NT program will be located in the 
Software by Design folder on the Programs menu. This item will be disabled (grayed) if a NoteBook item already exists in the 
Software by Design folder.

Remove this Start Menu Item
Check this item to remove the NoteBook entry located in the Software by Design folder on the Programs menu. This item will 
be disabled (grayed) if a NoteBook item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a NoteBook for Windows 95/NT program icon on the Explorer desktop. This item will be disabled 
(grayed) if a NoteBook desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the NoteBook for Windows 95/NT program icon from the Explorer desktop. This item will be 
disabled (grayed) if a NoteBook desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run NoteBook for Windows 95/NT whenever Microsoft Windows is started. This option 
creates a NoteBook program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
NoteBook startup item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove NoteBook from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
NoteBook startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the 
NoteBook Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the NoteBook Explorer Setup property sheet without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the NoteBook Help window and go directly to the NoteBook Explorer Setup topic.



File Menu
File Menu Commands
The File menu provides commands to work with the document files used by NoteBook. A short description of each item follows:

New
Creates a new NoteBook document. The Ctrl+N shortcut can be used for this command.

Open
Opens an existing NoteBook document, and loads it for editing or viewing. When this item is selected the standard MS 
Windows Explorer file browser will be displayed, use this window to select the document you wish to work with. Check the 
Open as Read-Only box to load documents for viewing only. The Ctrl+O shortcut can be used for this command.

Properties
Displays a small window showing file properties for the currently selected NoteBook document. This window will display the
document’s file name, folder location, size, last modification date and file access permissions. The Alt+Enter shortcut can 
be used for this command.

Close
Closes the currently active document. If the document has been edited you will be prompted to save or discard the changes
before closing. The Ctrl+W shortcut can be used for this command.

Save
Saves changes made to the currently selected document. This menu item will be disabled (grayed) if no changes have 
been made to the document since it was last loaded or saved. The Ctrl+S shortcut can be used for this command.

Save As
Saves the currently active NoteBook document with a new name. When this item is selected the standard MS Windows 
Explorer file browser will be displayed, use this window to specify a new name for the NoteBook document

Discard
Use this item to discard editing changes made to a NoteBook document, and reload the previous version from disk. This 
item will be disabled (grayed) if the document currently being edited has not changed since it was last saved or loaded.

Page Setup
Opens the NoteBook Page Setup property sheet, allowing you to specify custom headers, footers and page margin 
settings.

Printer Setup
Opens the standard MS Windows 95/NT Printer Setup property sheet, allowing you to select a printer and set various other 
printer options.

Print
Prints the currently selected NoteBook document on your system’s printer. The standard MS Windows 95/NT Print dialog 
box will appear before printing is started to allow you to select the printer to be used and various other printer options. The 
Ctrl+P shortcut can be used for this command.

Print TOC
Prints the currently selected NoteBook document’s Table of Contents page on your system’s printer. The standard MS 
Windows 95/NT Printer dialog box will appear before printing is started to allow you to select the printer to be used and 
various other printer options. The Alt+P shortcut can be used for this command.

Options
Opens the NoteBook Options property sheet and allows you to change NoteBook program settings. Use this command to 
configure the NoteBook program.

Recent Files
This command displays a sub-menu containing up to 9 recently edited NoteBook files. Select a file name from this list to 
quickly reopen a recently edited file.

Exit
Closes the NoteBook program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this 
command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to edit the contents of NoteBook documents. A short description of each item follows:

Undo
Undoes the last editing operation. This command will be dimmed (grayed) when the Table of Contents page is active. The 
Ctrl+Z shortcut can be used for this command.

Cut
Cuts the current selection from the document and places it on the Clipboard. When the Table of Contents page is active this
command will cut the entire NoteBook page currently selected and place it on the Clipboard. The Ctrl+X shortcut can be 
used for this command.

Copy
Copies the current selection to the Clipboard. When the Table of Contents page is active this command will copy the entire 
NoteBook page currently selected and place it on the Clipboard. The Ctrl+C shortcut can be used for this command.

Paste
Pastes the contents of the Clipboard at the current selection point. When the Table of Contents page is active this 
command will paste the current contents of the Clipboard into the currently selected NoteBook page. The Ctrl+V shortcut 
can be used for this command.

Delete
Deletes the current selection, but does not place a copy on the Clipboard. When the Table of Contents page is active this 
command will delete the entire NoteBook page currently selected without placing it on the Clipboard. The Del shortcut can 
be used for this command.

Select All
Selects the entire contents of the current document. This command will be dimmed (grayed) when the Table of Contents 
page is active. The Ctrl+A shortcut can be used for this command.

Insert Date
Inserts the system time and date at the current cursor location while editing individual NoteBook pages. This command will 
be dimmed (grayed) when the Table of Contents page is active. The F5 shortcut can be used for this command.

Export to File
Exports the currently selected NoteBook page from the Table of Contents as a plain ASCII text file. This command will be 
dimmed (grayed)    when an individual NoteBook page is displayed or edited. The Alt+X shortcut can be used for this 
command.

Find
Opens the Find dialog box and allows you to search for specified text or phrases. Individual NoteBook pages or the entire 
NoteBook document can be searched using this window. The Ctrl+F shortcut can be used for this command.

Replace
Opens the Replace dialog box and allows you to search for specified text or phrases and optionally make replacements. 
Individual NoteBook pages or the entire NoteBook document can be searched using this window. The Ctrl+R shortcut can 
be used for this command.

Edit Selection
Displays the currently selected NoteBook page from the Table of Contents and allows editing changes to be made. This 
command has the same effect as double-clicking the mouse on an individual entry in the Table of Contents. This command 
will be dimmed (grayed)    when an individual NoteBook page is displayed or edited. The Ctrl+E shortcut can be used for 
this command.

Read Only
Turns editing permission on and off. If this item is checked the document can be viewed but editing is not allowed.

Tip Commonly used Edit commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change NoteBook display options. These items provide a means of changing the 
NoteBook window appearance. A short description of each item follows:

Toolbar
Use this command to turn the toolbar ribbon on and off. If this item is checked the NoteBook toolbar ribbon will be displayed
below the menu bar. To hide the toolbar ribbon uncheck this item. Most commonly used NoteBook menu commands have a
toolbar button. If the toolbar ribbon is turned off you will have to use the normal NoteBook menu commands.

Status Bar
Use this command to turn the status region on and off. If this item is checked the NoteBook status region will be displayed 
at the bottom of the NoteBook window. To hide the status region uncheck this item. The status region displays current 
program status and will also display a brief description of each menu command as the mouse is moved through these 
items.

Customize
Use this command to customize the NoteBook for Windows 95/NT toolbar ribbon. The standard MS Windows Toolbar 
Customization property sheet will be opened and displayed when this command is selected.

Table of Contents
Displays the Table of Contents and makes it active. This command will be dimmed (grayed) if the Table of Contents page is 
currently active. The Ctrl+T shortcut can be used for this command.

Next Note
Displays the next NoteBook page in the current document. The Ctrl+PgDn shortcut can be used for this command.

Previous Note
Displays the previous NoteBook page in the current document. The Ctrl+PgUp shortcut can be used for this command.

Sort by Status
Use this command to sort the Table of Contents entries by their current status. Pages you have marked as Urgent will be 
displayed ahead of normal and Completed items. This command will be dimmed (grayed)    when an individual NoteBook 
page is displayed or edited. The Alt+S shortcut can be used for this command.

Sort by Contents
Use this command to sort the Table of Contents entries by alphabetical order. This command will be dimmed (grayed)    
when an individual NoteBook page is displayed or edited. The Alt+C shortcut can be used for this command.

Dial
This command will dial the telephone using the phone number selected from an individual NoteBook page. This command 
is useful if you use NoteBook to store telephone numbers. The Ctrl+D shortcut can be used for this command. See the 
NoteBook Serial and Modem configuration sections of this manual for more information about configuring your computer 
system to use NoteBook as a telephone dialer.

Visit URL
This command will launch your Internet web browser using the URL selected from an individual NoteBook page. This 
command is useful if you use NoteBook to store web site URLs. The Ctrl+G shortcut can be used for this command.

Tip Double-click your mouse on a URL to select it and then use the Visit URL command to quickly launch your web 
browser and go directly to the web site you have selected.

Minimize
Minimizes the NoteBook window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the NoteBook window top most on the desktop. When this item is checked the NoteBook 
window will float above all other non-topmost windows on the desktop. This item is useful if you normally run NoteBook with
a small window that would be easily obscured by other applications.

Fonts
Select this menu item to display a sub-menu containing Display Font and Printer Font settings. The standard MS 
Windows Font Selection dialog box will be displayed. Use this window to select the font you wish to use for displaying and 
printing NoteBook document pages.

Tip Commonly used View commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Table Menu
Table Menu Commands
The Table menu provides commands used to manipulate the Table of Contents (TOC) view. A short description of each item 
follows:

Insert Note
Inserts a new empty note in the Table of Contents. The currently selected note will be moved down to make room for the 
newly inserted note. The Ctrl+Ins shortcut can be used for this command.

Remove Note
Deletes the currently selected note from the Table of Contents. The Ctrl+Del shortcut can be used for this command.

Move Up
Moves the currently selected note up through the Table of Contents. The Ctrl+Up shortcut can be used for this command.

Move Down
Moves the currently selected note down through the Table of Contents. The Ctrl+Down shortcut can be used for this 
command.

Urgent
Marks the currently selected note in the Table of Contents as urgent. Items marked as urgent will be displayed in red. You 
can also Ctrl-Click your mouse on an entry to mark it as urgent. To unmark an urgent item use this command a second 
time. The Ctrl+U shortcut can be used for this command.

Completed
Marks the currently selected note in the Table of Contents as completed. Items marked as completed will be displayed in 
light gray. You can also Shift-Click your mouse on an entry to mark it as completed. To unmark a completed item use this 
command a second time. The Ctrl+L shortcut can be used for this command.

Compact Notes
Compacts the Table of Contents, moving empty NoteBook pages to the end of the Table of Contents list. The Ctrl+K 
shortcut can be used for this command.

Tip Commonly used Table commands can be invoked using shortcut keys.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with NoteBook operations. A short description of each item follows:

Contents
Opens the NoteBook Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens NoteBook Help and displays the Search window. You can use this window to search for specific NoteBook help 
topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the NoteBook Shareware Registration Wizard. This wizard allows you to register    NoteBook for Windows 95/NT 
for authorized use.

Setup
Displays the NoteBook Explorer Setup property sheet. This window provides options to integrate NoteBook with the MS 
Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software by Design web site on the Internet.

About NoteBook
Displays the NoteBook splash box. This window contains program information, the current version of NoteBook you are 
running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Customizing the Toolbar
Customizing the Toolbar Ribbon
The NoteBook toolbar ribbon can be customized by selecting the View | Customize menu item. The standard MS Windows 
95/NT Toolbar Customization dialog box will be opened when this command is invoked. Use this window to add and remove 
NoteBook toolbar buttons as well as to change the order that the buttons appear on the toolbar ribbon.

Tip you can also move and delete toolbar buttons without opening the Toolbar Customization dialog box by simply shift-clicking 
with your mouse and dragging the button to a new location on the NoteBook toolbar ribbon itself. To delete buttons shift-click 
and drag the button off of the NoteBook toolbar ribbon.

Note Some versions of MS Windows 95 redraw the toolbar ribbon height incorrectly after customization, if this happens exit 
NoteBook and then restart it again to restore the proper toolbar ribbon height.

Available Buttons
This list will contain the buttons available for adding to the NoteBook toolbar ribbon. Only buttons not currently installed on the
toolbar ribbon will be displayed in this list.

Toolbar Buttons
This list will contain the buttons currently installed on the NoteBook toolbar ribbon.

Add
Press the Add button after selecting a toolbar button from the Available list. The tool button you have selected will be added to
the NoteBook toolbar ribbon at the current selection point.

Remove
Press the Remove button after selecting a toolbar button from the Toolbar list. The tool button you have selected will be 
removed from the NoteBook toolbar ribbon.

Close
Press the Close button to finish toolbar customization. The selection of toolbar buttons that you chose to include will be saved
and reloaded whenever NoteBook for Windows 95/NT is started.

Reset
Press the Reset button to restore the NoteBook toolbar ribbon to its original default settings.

Help
Press the Help button to open the NoteBook Help file and go directly to the Customizing the Toolbar topic.

Move Up
Use this button to move the currently selected button up one place in the toolbar button list. The currently selected button will 
appear one place to the left on the actual NoteBook toolbar ribbon when this command is used.

Move Down
Use this button to move the currently selected button down one place in the toolbar button list. The currently selected button 
will appear one place to the right on the actual NoteBook toolbar ribbon when this command is used.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used NoteBook menu commands can also be quickly invoked by pressing a button on the toolbar ribbon 
displayed at the top of the main window. These buttons work exactly the same way as the corresponding menu items that they 
duplicate.

The Toolbar selection on the View menu must be selected to display the toolbar ribbon.

The number of buttons and their order on the toolbar ribbon may vary from the description below if you have customized the 
NoteBook toolbar ribbon.

New - Create a new document

Open - Open an existing document

Save - Save changes made to a document

Close – Close the current document

Save As - Save current document with a new name

Properties – Display information about the document

Print - Print the current document

Undo - Undo last editing change

Cut - Cut the current selection

Copy - Copy the current selection

Paste - Paste Clipboard contents

Delete – Delete the current selection

Table - Display the Table of Contents

Previous - Display the Previous note

Next - Display the Next note

Edit - Edit the current selection

Timestamp – Insert time and date

Sort by Contents – Sort notes by contents

Sort by Status – Sort notes by status type

Find - Search for specified text

Replace - Search and replace specified text

Dial – Dial the selected telephone number

Visit URL – Visit the selected web site URL

Font – Select the display font



Topmost – Make the NoteBook window topmost

Options - Open the NoteBook Options dialog

Help - Open this Help file

About - Show NoteBook splash box

Tip If the Show ToolBar Tips option is selected a small popup tip window will appear when the mouse pointer is placed over a 
button. A short description of what each button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke NoteBook menu commands without first displaying the menu and then selecting an 
item from it. The most commonly used NoteBook commands can be invoked using the following shortcut keys.

File Menu
Ctrl+N Create a new document
Ctrl+O Open an existing document
Alt+Enter Show properties for current document
Ctrl+W Close the current document
Ctrl+S Save changes made to the document
Ctrl+P Print the current document
Alt+P Print the current document’s TOC
Ctrl+Q Exit NoteBook, and return to the desktop

Edit Menu
Ctrl+Z Undo the last editing change
Ctrl+X Cut the current selection
Ctrl+C Copy the current selection
Ctrl+V Paste to the current position
Del Delete the current selection
Ctrl+A Select the entire page
F5 Insert Date/Time at current location
Ctrl+F Find specified text
Ctrl+R Replace specified text
Ctrl+E Edit selected item

View Menu
Ctrl+T Table of Contents
Ctrl+PgDn Next Note
F3 Next Note
Ctrl+PgUp Previous Note
F2 Previous Note
Alt+S Sort TOC by Status
Alt+C Sort TOC by Contents
Ctrl+D Dial the selected telephone number
Ctrl+G Visit the selected web site URL
Ctrl+Y Minimize NoteBook to a button or icon

Table Menu
Ctrl+Ins Insert Note
Ctrl+Del Remove Note
Ctrl+Up Move Up
Ctrl+Down Move Down
Ctrl+U Mark as Urgent
Ctrl+L Mark as Completed
Ctrl+K Compact Notes

Help Menu
F1 Display this Help file

Note The Ctrl+Up and Ctrl+Down command shortcuts use the arrow keys on the keyboard.



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in NoteBook for Windows 95/NT please feel free to contact me on 
CompuServe.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



Release History
NoteBook for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added an option to display notes with a light gray window background. Find and Replace dialog box desktop locations 
are now saved in the NOTEBOOK.INI file. 

v2.3 Fixed a bug involving program launches from the MS Windows 95/NT Start Menu using quoted command strings.

v2.4 Improved page printing routines. Notes are now printed on individual pages instead of four notes per page.

v2.5 Increased page size to 5K from the original 3K limit. Increased window size in both the horizontal and vertical 
dimensions.

v2.6 Added a Drag & Drop interface to quickly load NoteBook pads and ASCII text files directly from the MS Windows 
desktop. Modified the NoteBook Options dialog box, and fixed a launch bug. Added the Export to File item to the Edit 
menu.

v2.7 Added an option to place a NoteBook icon in the Taskbar Notification Tray. Added bullets to the head of TOC entries. 
Added document backups to the file I/O routines.

v2.8 Fixed a DEL key bug that prevented the characters on the right of the cursor from being deleted properly.

v2.9 Increased NoteBook Pad document size from 40 to 50 pages. Added an optional document backup item to the NoteBook
Options dialog. Dropping text files on an open NoteBook page was changed to insert contents instead of replacing the 
original note. Added the NoteBook Time Stamp Settings dialog box for configuring Time and Date formats. Included a 
facility to open the Regional Setting control panel applet.

v3.0 Added support for screen color settings as specified in the Display Properties dialog. Added default user and company 
name to the splash box.

v3.1 Fixed a bug that caused a program crash (GPF) when exiting via the File | Exit menu command.

v3.2 Added an MS Window 95/NT Help file and automated MS Explorer   Setup   facilities. Moved NoteBook configuration 
setting from the NOTEBOOK.INI file to the MS Windows 95/NT System Registry.

v3.3 Added help buttons to the various NoteBook dialog boxes. Added an option to start NoteBook as a minimized icon.

v3.4 Converted the NoteBook Options dialog box to a five-tab property sheet. Added a Page Setup command to configure 
custom headers, footers and page margin settings.

v3.5 Added facilities to customize the NoteBook toolbar ribbon.

v3.6 Fixed a bug that prevented proper window repositioning if the MS Explorer Taskbar is placed along the left edge or at the
top of the desktop and the Auto Hide option is active. Fixed several printing bugs. Increased the maximum width of the 
main NoteBook window to 640 pixels. Added additional toolbar ribbon buttons.

v3.7 Added a Recent Files submenu to the File Menu to quickly load previously edited files. Fixed a bug that prevented the 
proper font size when printing NoteBook documents.

v3.8 Added Sort by Contents and Sort by Status toolbar buttons. NoteBook now behaves like a true Taskbar Tray application 
when the Place Icon in the Taskbar Tray option is selected. Several other minor bugs have been fixed.

v3.9 Added an option to number individual NoteBook pages in the Table of Contents view. Removed BLink’s Shrinker file 
compression from the executable.

v4.0 Right-clicking the mouse on the NoteBook icon in the Taskbar tray will now exit the program. Added a facility to launch a 
web browser and go directly to a highlighted web site URL. A NoteBook document’s TOC can now be printed. Added 
telephone dialer functions using a modem connected to the system. The NoteBook main viewing window can now be 
maximized. Added Dial and Web Browser toolbar buttons. Fixed several other minor bugs.

v4.1 Fixed several minor bugs.

Last Update  March 11th, 1998



Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



System Registry
NoteBook for Windows 95/NT System Registry Key
NoteBook for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are 
updated automatically while NoteBook is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. NoteBook automatically updates registry entries when it 
exits. If you edit these settings make sure NoteBook is not running while you edit them. If NoteBook is currently running your 
changes will be overwritten when NoteBook exits.

NoteBook for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
NoteBook for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. NoteBook will automatically maintain these settings for you. If you do 
edit these, you do so at your own risk.



Removing NoteBook
Removing NoteBook for Windows 95/NT
If you find that NoteBook for Windows 95/NT does not meet your note taking needs you can remove it from your computer 
system by simply deleting the following files from your hard drive. All of these files will be located in the folder that you originally 
installed NoteBook in.

NoteBook.exe NoteBook application program.
NoteBook.cnt NoteBook Help Topics File
NoteBook.hlp NoteBook Help File

If you have opened and used the NoteBook for Windows 95/NT Help files your system may contain the following two (2) files. 
These files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely 
removed.

NoteBook.gid MS Windows Help settings file. This file contains the NoteBook Help window size and desktop location as
well as any bookmarks you may have created.

NoteBook.fts MS Windows Help word database. This file is created when you build a custom word list for NoteBook 
Help files. This file is used to search for words and phrases in the NoteBook Help files.

NoteBook for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above from 
your system’s hard drive you will have completely removed NoteBook from your computer system.

Note If you have installed NoteBook shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the NoteBook files mentioned above.



Software by Design Web Site
Software by Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software by Design web site.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"NoteBook for Windows 95/NT v4.1"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering NoteBook for Windows 95/NT
Registering NoteBook
NoteBook for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use NoteBook for Windows 95/NT you are required to register it. If after evaluating NoteBook for 30 days you decide 
not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register NoteBook for Windows 95/NT by mailing the Order Form provided with this software. When you register 
NoteBook for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your 
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when NoteBook for Windows 95/NT is first launched.

To register your copy of NoteBook for Windows 95/NT select the Help | Register menu command. The Shareware Registration 
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered NoteBook for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered NoteBook for Windows 95/NT. If you did not 
specify an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased NoteBook for Windows 95/NT. Refer to the notification 
letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered NoteBook for Windows 95/NT. When you successfully register your
copy of NoteBook this box will automatically be unchecked for you. If you wish to see the splash box when NoteBook is 
launched return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete NoteBook for Windows 95/NT 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the NoteBook Help window and go directly to the Registering NoteBook topic.



Purchasing Information
Purchasing Information
NoteBook for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use NoteBook for Windows 95/NT you are required to register it. If after evaluating NoteBook for 30 days you decide 
not to purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register NoteBook for Windows 95/NT by mailing the Order Form provided with this software. When you register 
NoteBook for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your 
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when NoteBook for Windows 95/NT is first launched.

Single User Licensing
Individual users can register NoteBook for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to 
you please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of NoteBook directly from the Software by Design web site on the Internet. Print the 
NoteBook for Windows 95/NT Order Form and mail it with your check to become a registered user of NoteBook for Windows 
95/NT.

Site Licensing
NoteBook for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install and 
use NoteBook on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk
and entitles you to unlimited free updates and telephone support. You can always download the latest release of NoteBook 
directly from the Software by Design web site on the Internet. Print the NoteBook for Windows 95/NT Order Form and mail it with
your check to become a registered user of NoteBook for Windows 95/NT.

Corporate Licensing
NoteBook for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and 
use NoteBook on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy 
disk and entitles you to unlimited free updates and telephone support. You can always download the latest release of NoteBook 
directly from the Software by Design web site on the Internet. Print the NoteBook for Windows 95/NT Order Form and mail it with
your check to become a registered user of NoteBook for Windows 95/NT.



NoteBook for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to:

Gregory Braun
5609 West Hadley Street
Milwaukee, WI    53210-1554 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of NoteBook for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of NoteBook for Windows 95/NT may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not 
both.

Site License
Any number of users at a single location may access the registered version of NoteBook for Windows 95/NT through a 
network, provided that you have obtained a site license for the software covering all workstations that will access the software 
through the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of NoteBook for Windows 95/NT through a
network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of NoteBook for Windows 95/NT are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software by Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.




